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Supplementary figures 

 
Fig. S1 Photophysical properties of SCouK. (A) Structures of SCouK and HCK. (B) Absorption 

spectra of SCouK (λab, max = 453 nm) and HCK (λab, max = 329 nm). (C) Fluorescence emission 

spectra of SCouK and HCK. (D) Enlarged fluorescence emission spectrum of SCouK. SCouK 

and HCK were dissolved in phosphate-buffered saline (PBS) (20 mM, pH 7.4; containing 0.01% 

DMSO) at 10 μM concentrations. Fluorescence emission spectra of SCouK and HCK were 

recorded with excitation at 453 nm and 329 nm, respectively. Note: SCouK exhibits stronger 

absorption but approximately 144-fold weaker fluorescence compared to HCK. Data in (B), 

(C), and (D) are representative of three independent experiments. 

 

 

 
Fig. S2 Proposed mechanism of photolysis of the thiocoumarin lysine SCouK to generate a 

native lysine and thiocoumarin SCou-OH.  
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Fig. S3 Characterization of photolysis of the thiocoumarin lysine derivative Na-Fmoc-SCouK 

in vitro. (A) The photolysis reaction of Na-Fmoc-SCouK to generate decaged Na-Fmoc-K and 

SCou-OH. (B) Representative LC-MS analysis of Na-Fmoc-SCouK photolysis showing the 

efficient generation of Na-Fmoc-K. Na-Fmoc-SCouK (50 μM) was dissolved in CH3CN and 

PBS (CH3CN/PBS = 2:8). The solution was irradiated with a 520 nm LED (22 mW/cm2) for 

varying periods (10, 30, 60, and 120 s). The resulting mixture was analyzed by HPLC-MS, 

with a UV detector set at the wavelength of 254 nm. The experiments were performed in four 

replicates with reproducible results. The peak areas of Na-Fmoc-SCouK in the HPLC traces 

were used to calculate its conversions, using the non-irradiated Na-Fmoc-SCouK sample as 

the reference. Each replicate dataset of Na-Fmoc-SCouK conversion was individually fitted to 

a nonlinear one-phase exponential decay model to calculate the half-life (t1/2) of SCouK 

photodecaging. The resulting half-life values were averaged. (C) Mass spectrum of the 

generated SCou-OH with a retention time at 9.31 min. Data in (B) and (C) are representative 

of three independent experiments. 
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Fig. S4 (A) Photolysis of the thiocoumarin lysine derivative Na-Fmoc-SCouK under different 

pH conditions. Na-Fmoc-SCouK (50 μM) was dissolved in CH3CN and PBS at different pH 

values (CH3CN/PBS = 2:8). The solution was irradiated with a 520 nm LED (22 mW/cm2) for 

30 s with a distance of 20 cm. The resulting mixture was analyzed by HPLC-MS, with a UV 

detector set at the wavelength of 254 nm. The peak areas of Na-Fmoc-SCouK and Na-Fmoc-

K in the HPLC traces were used to calculate the conversions and yields, using known 

concentrations of Na-Fmoc-SCouK and Na-Fmoc-K as references. The experiments were 

performed in three replicates with reproducible results. Data are shown as mean ± SD (n = 3). 

(B) The maximal absorbance of SCouK at 453 nm under different pH conditions. (C) 

Absorption spectra of SCouK under different pH conditions. For the measurement of 

absorption, SCouK (10 μM) was dissolved in PBS (20 mM, containing 0.01% DMSO) at 

different pH values. Data in (B) and (C) are representative of three independent experiments. 
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Fig. S5 (A) Overlay of the absorption spectrum of SCouK (10 μM in PBS at pH 7.4 containing 

0.01% DMSO) with the emission spectrum of the 520 nm LED used in this study. (B) Emission 

spectrum of the 520 nm LED used in this study. The emission below 490 nm and above 570 

nm contributed approximately 6% and 2%, respectively, to the total output, confirming that the 

LED predominantly emits green light centered around 520 nm. (C) Overlay of the absorption 

spectrum of SCouK (10 μM in PBS at pH 7.4 containing 0.01% DMSO) with the emission 

spectrum of the 450 nm LED used in this study. Data are representative of three independent 

experiments. 

 

 
Fig. S6 Maps of plasmids used in this study for protein expression in E. coli.  
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Fig. S7 (A) Schematic of the principle for site-specifically encoding SCouK into EGFP-

Y39TAG via the genetic code expansion technology. (B) Screening of MmPylRS mutants for 

site-specific incorporation of SCouK into EGFP-Y39TAG in E. coli. The pLX-EGFP-Y39TAG-

PylT plasmid was co-transformed with individual pBX-MmPylRS variants into E. coli strain 

BL21(DE3). The transformed bacteria cells were grown in LB medium overnight at 37 °C and 

then inoculated by 1:100 dilution into LB medium. SCouK (1 mM) was added into the bacterial 

culture when OD600 reached 0.6. After 0.5 h incubation, protein expression was induced with 

1 mM isopropyl-β-D-thiogalactoside (IPTG) for 10 h at 37 °C. The EGFP fluorescence intensity 

of individual bacterial culture was measured on a microplate reader and compared with the 

control culture in the absence of SCouK. The fluorescence was normalized to OD600. (C) 

Validation of MmPylRS mutants for site-specific incorporation of SCouK into EGFP-Y39TAG 

in E. coli. The indicated bacterial cultures were lysed and analyzed by Coomassie Brilliant 

Blue (CBB) staining. The screening experiment shown in (B) was performed once for initial 

assessment, and selected variants were subsequently validated in (C), which represents 

reproducible results from two biological replicates.  
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Fig. S8 Concentration-dependent incorporation of SCouK into 6*His-tagged sfGFP-N150TAG 

in E. coli. The pLX-sfGFP-N150TAG-PylT plasmid was co-transformed with the pBX-

SCouKRS plasmid into E. coli strain BL21(DE3). After overnight culture at 37 °C, the 

transformed bacteria cells were inoculated by 1:100 dilution into LB medium. SCouK at 

different concentrations (from 0 to 2 mM) was added into the bacterial culture when OD600 

reached 0.6. After 0.5 h, protein expression was induced with 1 mM IPTG for 10 h at 37 °C. 

Cells were harvested and lysed with 4% SDS lysis buffer. Cell lysates were analyzed by 

western blotting and Coomassie Brilliant Blue (CBB) staining. Data are representative of three 

independent experiments. 

 

 

 

 

 

 

 

 

 

 

CBB

anti-His

kDa

sfGFP-N150TAG-His

SCouK (mM) 0 0.25 0.5 1 2

30-

22-

53-

41-



S10 

 

 
Fig. S9 Electrospray ionization mass spectrometry (ESI-MS) analyses of photolysis of SCouK 

at the protein level. (A) Schematic for photolysis of 6*His-tagged sfGFP-N150SCouK to 

generate 6*His-tagged sfGFP-N150K. (B) Deconvoluted and (C) original ESI-MS spectra of 

the sfGFP-N150SCouK protein. Calculated mass of sfGFP-N150SCouK: 28075.28 Da; 

observed mass: 28075.30 Da. (D) Deconvoluted and (E) original ESI-MS spectra of the 

sfGFP-N150SCouK protein after photoirradiation. Calculated mass of sfGFP-N150K: 

27841.39 Da; observed mass: 27840.56 Da. The pLX-sfGFP-N150TAG-PylT plasmid was co-

transformed with the pBX-SCouKRS plasmid into E. coli strain BL21(DE3). After overnight 

culture at 37 °C, the transformed bacteria cells were inoculated by 1:100 dilution into LB 

medium. SCouK (1 mM) was added into the bacterial culture when OD600 reached 0.6. After 

0.5 h, protein expression was induced with 1 mM IPTG for 10 h at 37 °C. Cells were lysed and 

the proteins were purified by Ni-NTA Sefinose Resin for ESI-MS analysis. For photolysis of 

the recombinant protein in vitro, sfGFP-N150SCouK (1 μM) in PBS was irradiated with a 520 

nm LED (22 mW/cm2) for 30 s and analyzed by ESI-MS. Data are representative of two 

independent experiments. 
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Fig. S10 Maps of plasmids used in this study for protein expression in mammalian cells. 
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Fig. S11 Site-specific incorporation of SCouK into sfGFP-N150TAG in mammalian cells. (A) 

Concentration-dependent incorporation of SCouK into sfGFP-N150TAG in HEK293T cells 

analyzed by western blotting. (B) Representative widefield fluorescence imaging of sfGFP-

N150SCouK expression in the presence of varying concentrations of SCouK in live HEK293T 

cells. Scale bar represents 100 μm. (C) Quantification of fluorescence images shown in (B). 

Data are shown as mean ± SD (n = 3). Statistical analysis was performed with one-way 

ANOVA, ∗∗∗∗p < 0.0001. HEK293T cells were transfected with plasmids of pCMV-sfGFP-

N150TAG and pEF1α-SCouKRS-PylT in the presence of SCouK at indicated concentrations 

for 24 h and analyzed by western blotting or widefield fluorescence microscopy. Data in (A) 

are representative of three independent experiments. 
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Fig. S12 Cytotoxicity of SCouK and its decaging product. (A) HEK293T cells were treated with 

SCouK at different concentrations for 24 h. (B) HEK293T cells were treated with SCouK at 

different concentrations for 0.5 h, irradiated with a 520 nm LED (22 mW/cm2) for 1 min, and 

further cultured for 24 h. Cell viability was measured by the CCK-8 assay. Data are shown as 

mean ± SD (n = 6). 

 

 

 

 
Fig. S13 Emission spectra of the LEDs used in this study. Detailed parameters of the LEDs 

are shown in Table S2.  
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Fig. S14 Spatial activation of EGFP fluorescence using SCouK through localized 

photoirradiation. HEK293T cells expressing EGFP-K85SCouK-mCherry were transferred to 

an Olympus IX73 inverted fluorescence microscope, focused using the bright-field channel, 

and locally irradiated for 10 s using a mercury lamp equipped with a green excitation filter set 

(bandpass 530–550 nm), followed by widefield fluorescence imaging of the live cells. Scale 

bars represent 100 μm. The white dashed circle indicates the area subjected to 

photoirradiation. Data are representative of two independent experiments. 
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Fig. S15 Photoactivation of FLuc-K529BocK using light at different wavelengths in HEK293T 

cells. (A) Cells were transfected with pCMV-FLuc-K529TAG and pEF1α-MmPylRS-PylT in the 

presence of BocK (0.2 mM) and illuminated with light at indicated wavelengths for 60 s, 

followed by western blot analysis. (B) Cells expressing FLuc-K529BocK were illuminated with 

light at indicated wavelengths for 60 s and examined for bioluminescence activities. Data in 

(B) are shown as mean ± SD (n = 3). (C) Western blot analysis of FLuc-K529TAG expression 

in the presence of UAAs (0.2 mM). HEK293T cells were transfected with pCMV-FLuc-

K529TAG and the corresponding synthetase/tRNA plasmids in the presence of BocK, HCK, 

or SCouK (0.2 mM) for 24 h, followed by western blot analysis. Data in (A) and (C) are 

representative of three independent experiments. 

 

 

 

 

 

(B)(A)

anti-His

FLuc-K529BocK-His

BL

anti-β-actin

Dark 390 450 520 650365

kDa

Wavelength
(nm)

41-

53-

Dark

36
5 n

m

39
0 n

m

45
0 n

m

52
0 n

m

65
0 n

m
0

20

40

60

80

Irradiation wavelength

B
io

lu
m

in
es

ce
nc

e 
in

te
ns

ity
 (a

. u
.) FLuc-K529BocK

(C)

anti-His

FLuc-K529TAG-His

anti-β-actin

−
kDa

UAA

41-

53-

Bo
cK
HC
K
SC
ou
K



S16 

 

 
Fig. S16 Activation of TBK1 and IRF3 phosphorylation in HEK293T cells by co-expression of 

cGAS and STING. Wild-type HEK293T cells were transfected with plasmids of pEF1α-cGAS-

HA and pB-EF1α-FLAG-STING-IRES-Puro as indicated for 24 h, whereas HEK293T cells 

stably expressing FLAG-tagged STING were transfected with the plasmid of pEF1α-cGAS-

HA as indicated for 24 h. After that, the cells were lysed and analyzed by western blotting. 

Data are representative of two independent experiments. 

 

 

 

 

 

 
Fig. S17 Two replicates of photoactivation of cGAS-K384SCouK in HEK293T cells stably 

expressing FLAG-STING. Cells were transfected with plasmids of pEF1α-cGAS-K384TAG-

HA and pEF1α-SCouKRS-PylT in the presence of SCouK (0.2 mM) for 24 h and irradiated 

with a 520 nm LED (22 mW/cm2) for 1 min. After that, the cells were cultured for indicated 

periods and lysed for western blotting analysis. Data are representative of three independent 

experiments. 
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Fig. S18 Sequential photoactivation of two proteins using SCouK and ONBY. (A) Expression 

of NLuc-Y96ONBY in HEK293T cells. (B) Sequential photoactivation of FLuc-K529SCouK and 

NLuc-Y96ONBY in HEK293T cells. Cells were co-transfected with a plasmid encoding FLuc-

K529TAG and a plasmid encoding SCouKRS and MmPyl-tRNACUA in the presence of SCouK 

(0.2 mM) to express FLuc-K529SCouK. Cells were co-transfected with a plasmid encoding 

NLuc-Y96TAG and a plasmid encoding ONBYRS and MmPyl-tRNACUA in the presence of 

ONBY (0.2 mM) to express NLuc-Y96ONBY. The cells expressing FLuc-K529SCouK, NLuc-

Y96ONBY, or FLuc-K529SCouK and NLuc-Y96ONBY were sequentially irradiated with light 

at 365 nm or 520 nm (22 mW/cm2) for 30 s as indicated. “First” and “Second” denotes the first 

and second irradiation events, respectively. After irradiation, FLuc and NLuc activities were 

examined and quantified. The asterisk (“365*”) indicates irradiation with 365 nm light for 1 min. 

(C) Quantification of chemiluminescence data shown in (B). Data in (A) are representative of 

three independent experiments. Data in (B) and (C) were obtained in one biological replicate, 

but key findings here were repeated with three independent experiments shown in Fig. 7 of 

the main text. 
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Supplementary table 

Table S1. Summary of photoactivatable lysine-derived UAAs. a  

UAA 
Decaging 

wavelength 
(nm) 

Decaging 
time 

Orthogonal 
RS/tRNA pair 

used for 
incorporation 

Organism 
Target  
protein 

Year Ref 

 
ONBK 

365 20 min 
MmPylRS/ 

MmPyl-tRNACUA 

E. coli, 

mammalian 

cells 
EGFP 2009 [1] 

 
PCK 

365 1–5 s 
MbPylRS/ 

MbPyl-tRNACUA 

E. coli,  

mammalian 

cells 

Nuclear 
localization 

signal (NLS), 

p53 

2010 [2] 

 
HCK, BHCK 

365,  

405, b  

760 c 

4 min  

(365 nm) 

MbPylRS/ 

MbPyl-tRNACUA 

E. coli,  

mammalian 

cells 

EGFP, 
luciferase  

2014 [3] 

 
ACK 

405  2 min 
MbPylRS/ 

MbPyl-tRNACUA 

E. coli,  

mammalian 

cells 

Luciferase, 

Cre 

recombinase, 

Protein 

Kinase A,  

NRAS 

2023 [4] 

HN

COOHH2N

O

O

NO2

HN

COOHH2N

O

O

NO2

O
O

HN

COOHH2N

O

O

OO OH

H/Br
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COOHH2N
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UAA 
Decaging 

wavelength 
(nm) 

Decaging 
time 

Orthogonal 
RS/tRNA pair 

used for 
incorporation 

Organism 
Target  
protein 

Year Ref 

 
NPEK 

365 30 s 
MbPylRS/ 

MbPyl-tRNACUA 

Mammalian 

cells 

NLS, 

luciferase 
2024 [5] 

 
NDBFK 

405 15 s 
MbPylRS/ 

MbPyl-tRNACUA 

Mammalian 

cells 

NLS, 

luciferase 
2024 [5] 

 
SCouK 

254,  

302,  

365,  

390,  

450,  

520 d 

30–60 s  

(520 nm) e 

MmPylRS/ 

MmPyl-tRNACUA 

E. coli,  

mammalian 

cells 

EGFP, 
luciferase, 

MEK1,  

Src,  

cGAS  

2025 
This 

work 

 
a Only photocaged lysine derivatives are listed here.  
b 405 nm: 30 mW diode laser, 20% laser power, 12.6 μs dwell time, 8 cycles.3 
c 760 nm (two-photon): 130 mW laser, 30 cycles of scanning.3 
d 390 nm, 450 nm, and 520 nm LEDs were used (Table S2).  
e 520 nm LED: Peak wavelength, 519 nm; Central wavelength, 520 nm; Dominant wavelength, 

521 nm; Centroid wavelength, 521 nm; Half width, 38 nm; Irradiance, 22 mW/cm2. 
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Table S2. Parameters of the LEDs used in this study. a 

LED name 390 nm LED 450 nm LED 520 nm LED 650 nm LED 

Peak wavelength (nm) b 389 436 519 662 

Central wavelength (nm) c 392 447 520 652 

Dominant wavelength (nm) d 447 454 521 634 

Centroid wavelength (nm) e 402 447 521 650 

Half width (nm) f 20 41 38 34 

Irradiance (mW/cm2) g 18 34 22 58 

 
a The spectra parameters of the LEDs used in this study were measured using a 

spectroradiometer. Each LED is referred to by its central wavelength.  
b Peak wavelength: the wavelength at which the emission intensity of the light source is 

maximum.  
c Central wavelength: the arithmetic midpoint between the wavelengths at which the emission 

intensity falls to half of the maximum value on either side of the peak. 
d Dominant wavelength: the wavelength of monochromatic light that would appear visually the 

same color to the human eye as the light source. 
e Centroid wavelength: the weighted average wavelength of a spectrum, calculated by taking 

the ratio of the quantum flux to the radiant flux or using a weighted average of intensity and 

wavelength. 
f Half width: also called full width at half maximum (FWHM), the spectral width of the emission 

curve measured between the two points where the intensity falls to half of the peak intensity. 
g Measured at the sample plane with a distance of 20 cm.  
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Table S3. Plasmids used in this study. 

Plasmid Promoter Gene Organism 

pBX-MmPylRS GlnRS Wild-type 
MmPylRS E. coli 

pBX-SCouKRS GlnRS SCouKRS 
(MmPylRS mutant) E. coli 

pLX-EGFP-Y39TAG-PylT 
lpp MmPyl-tRNACUA 

E. coli 
T5 EGFP-Y39TAG 

pLX-sfGFP-N150TAG-PylT 
lpp MmPyl-tRNACUA 

E. coli 
T5 sfGFP-N150TAG 

pEF1α-MmPylRS-PylT 
EF1α Wild-type 

MmPylRS Mammalian 
cells 4 × U6 4 × MmPyl-

tRNACUA 

pEF1α-SCouKRS-PylT 
EF1α SCouKRS 

(MmPylRS mutant) Mammalian 
cells 4 × U6 4 × MmPyl-

tRNACUA 

pEF1α-BhcKRS-PylT 
EF1α BhcKRS (MbPylRS 

mutant) Mammalian 
cells 4 × U6 4 × MmPyl-

tRNACUA 

pEF1α-ONBYRS-PylT 
EF1α ONBYRS 

(MbPylRS mutant) Mammalian 
cells 4 × U6 4 × MmPyl-

tRNACUA 

pCMV-sfGFP-N150TAG CMV sfGFP-N150TAG Mammalian 
cells 

pCMV-EGFP-K85TAG-mCherry CMV EGFP-K85TAG-
mCherry 

Mammalian 
cells 

pCMV-FLuc-K529TAG CMV FLuc-K529TAG Mammalian 
cells 

pCMV-NLuc-Y96TAG CMV NLuc-Y96TAG Mammalian 
cells 

pCMV-MEK1-ΔN-K97TAG-HA CMV MEK1-ΔN-K97TAG Mammalian 
cells 

pCMV-Src-Y527F-K295TAG-HA CMV Src-Y527F-
K295TAG 

Mammalian 
cells 

pEF1α-cGAS-HA 
EF1α cGAS Mammalian 

cells 4 × U6 4 × MmPyl-
tRNACUA 

pB-EF1α-FLAG-STING-IRES-Puro EF1α STING Mammalian 
cells 
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Chemical synthesis  

General information  

Chemicals and solvents were obtained from commercial sources and used directly as 

received. Chemical reactions were performed in oven-dried round-bottom flasks and 

monitored by TLC on silica gel 60 GF254 glass plates (Qingdao Haiyang Chemical). Spots on 

TLC were visualized by UV irradiation (254 nm) and staining with potassium permanganate 

(KMnO4). Flash column chromatography was performed with silica gel (200–300 mesh, 

reagent grade) from Accela. Nuclear magnetic resonance (NMR) spectra were recorded in 

CDCl3, CD3OD, or (CD3)2SO at room temperature on Bruker Avance NMR Spectrometers. 

Chemical shifts (δ) are reported in ppm and coupling constants (J values) are reported in Hz. 
1H NMR chemical shifts are calibrated using tetramethylsilane (TMS, δ = 0.00 ppm) in CDCl3 

as the internal standard or with the residual solvent peaks of CD3OD (δ = 3.31 ppm) or 

(CD3)2SO (δ = 2.50 ppm). 13C NMR chemical shifts are calibrated with the residual solvent 

peaks of CDCl3 (δ = 77.16 ppm), CD3OD (δ = 49.00 ppm), or (CD3)2SO (δ = 39.52 ppm). High 

resolution mass spectra (HRMS) were recorded on a Q Exactive Focus mass spectrometer 

(ThermoFisher).  

 

Synthesis of the unnatural amino acid SCouK  

SCouK was synthesized as shown in Scheme S1.  

 

Scheme S1. Synthetic scheme of SCouK. 
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4-(Chloromethyl)-7-hydroxy-2H-chromen-2-one (1) 

Compound 1 was prepared following literature procedures.6 Briefly, to a solution of 

resorcinol (10 g, 91.0 mmol) in 70% sulfuric acid (100 mL) at 0 °C was added ethyl 4-chloro-

3-oxobutanoate (12.5 mL, 91.0 mmol) dropwise. The reaction mixture was stirred at room 

temperature overnight. After that, the solution was poured into 500 mL of ice water. The 

precipitate was filtered, washed with water, and dried to give the desired product 1 as a white 

solid (10.7 g, 56% yield). 1H NMR (400 MHz, CDCl3) δ 7.52 (d, J = 8.6 Hz, 1H), 6.84 (dd, J = 

8.6, 2.4 Hz, 1H), 6.82 (d, J = 2.4 Hz, 1H), 6.37 (s, 1H), 4.63 (s, 2H). The 1H NMR data are 

consistent with previously reported.6 

 

 
7-Hydroxy-4-(hydroxymethyl)-2H-chromen-2-one (2) 

A solution of compound 1 (10.7 g, 51.0 mmol) in 400 mL of H2O was heated to reflux 

for 48 h. After that, the solution was cooled to room temperature and placed at 0 °C for 24 h. 

The precipitate was filtered, washed with water, and dried to give the desired product 2 as a 

white solid (6.6 g, 67% yield). 1H NMR (500 MHz, CD3OD) δ 7.50 (d, J = 8.7 Hz, 1H), 6.79 (dd, 

J = 8.7, 2.4 Hz, 1H), 6.72 (d, J = 2.4 Hz, 1H), 6.36 (s, 1H), 4.81 (d, J = 1.6 Hz, 2H). The 1H 

NMR data are consistent with previously reported.6 

 

 
(7-Acetoxy-2-oxo-2H-chromen-4-yl)methyl acetate (3) 

To a solution of compound 2 (6.6 g, 34.1 mmol) in anhydrous tetrahydrofuran (THF; 

100 mL) was added acetic anhydride (19.0 mL, 204.8 mmol), pyridine (2.76 mL, 34.1 mmol), 

and 4-dimethylaminopyridine (DMAP; 417 mg, 3.41 mmol) successively. The reaction mixture 

was stirred at room temperature for 2 h and quenched with water. The mixture was extracted 

with ethyl acetate (EA), washed with water and brine, and dried with anhydrous Na2SO4. After 

filtration, the organic phase was concentrated under vacuum. The crude product was purified 

by flash column chromatography (petroleum ether (PE)/EA = 5:1) to give product 3 as a white 

O OHO

Cl

1

O OHO

OH

2

O OAcO

OAc

3
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solid (7.7 g, 82% yield). 1H NMR (400 MHz, CDCl3) δ 7.53 (d, J = 8.7 Hz, 1H), 7.17 (d, J = 2.3 

Hz, 1H), 7.10 (dd, J = 8.6, 2.3 Hz, 1H), 6.48 (s, 1H), 5.28 (d, J = 1.5 Hz, 2H), 2.35 (s, 3H), 

2.22 (s, 3H). 13C NMR (101 MHz, CDCl3) δ 170.2, 168.8, 160.2, 154.5, 153.4, 148.7, 124.5, 

118.6, 115.1, 112.9, 111.0, 61.2, 21.2, 20.8. HRMS calcd for C14H12O6 [M+H]+: 277.0707; 

found: 277.0708. 

 

 
(7-Acetoxy-2-thioxo-2H-chromen-4-yl)methyl acetate (4) 

To a solution of compound 3 (7.7 g, 28.0 mmol) in anhydrous m-xylene (150 mL) was 

added Lawesson’s reagent (9.1 g, 22.4 mmol). The mixture was heated to reflux in the dark 

for 6 h. After that, the mixture was concentrated under vacuum. The crude product was purified 

by flash column chromatography (PE/EA = 5:1) to give product 4 as an orange solid (5.6 g, 

69% yield). 1H NMR (400 MHz, CDCl3) δ 7.55 (d, J = 8.7 Hz, 1H), 7.29 (d, J = 2.2 Hz, 1H), 

7.26 (s, 1H), 7.13 (dd, J = 8.7, 2.2 Hz, 1H), 5.21 (d, J = 1.3 Hz, 2H), 2.35 (s, 3H), 2.20 (s, 3H). 
13C NMR (101 MHz, CDCl3) δ 196.9, 170.2, 168.6, 156.8, 153.6, 139.6, 126.4, 124.4, 119.6, 

116.6, 110.7, 60.9, 21.3, 20.9. HRMS calcd for C14H12O5S [M+H]+: 293.0478; found: 293.0478. 

 

 
7-Hydroxy-4-(hydroxymethyl)-2H-chromene-2-thione (5)  

To a solution of compound 4 (5.6 g, 19.3 mmol) in ethanol (80 mL) was added 

concentrated HCl (8 mL). The mixture was heated to reflux in the dark for 1 h. After that, the 

reaction mixture was concentrated under vacuum and diluted with EA. The organic layer was 

washed with brine, dried over anhydrous Na2SO4, filtered, and concentrated under vacuum. 

The resulting crude product was purified by flash column chromatography (CH2Cl2/MeOH = 

60:1) to give product 5 as an orange solid (3.3 g, 83% yield). 1H NMR (400 MHz, CD3OD) δ 

7.57 (d, J = 9.0 Hz, 1H), 7.23 (s, 1H), 6.89 – 6.85 (m, 1H), 6.85 (d, J = 1.3 Hz, 1H), 4.77 (d, J 

= 1.4 Hz, 2H). 13C NMR (101 MHz, CD3OD) δ 199.7, 163.3, 159.3, 149.4, 126.3, 122.7, 115.7, 

113.1, 103.3, 60.5. HRMS calcd for C10H8O3S [M+H]+: 209.0267; found: 209.0267.  

 

O SAcO

OAc

4

O SHO

OH
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N2-(tert-Butoxycarbonyl)-N6-(((7-hydroxy-2-thioxo-2H-chromen-4-
yl)methoxy)carbonyl)-L-lysine (7) 

To a solution of compound 5 (1.8 g, 8.6 mmol) in anhydrous THF (30 mL) at 0 °C was 

added a solution of triethylamine (TEA; 1.8 mL, 13.0 mmol) and nitrophenyl chloroformate (2.6 

g, 13.0 mmol) in THF (20 mL) under a N2 atmosphere. The reaction was then allowed to warm 

to room temperature and stirred in the dark for 4 h. The reaction mixture was diluted with EA 

and washed with a saturated aqueous solution of NaHCO3 and brine. The organic layer was 

dried over anhydrous Na2SO4, filtered, and evaporated under vacuum to give the crude 

product 6 as a yellow solid (1.4 g, 43% yield) without further purification. To a solution of Nα-

Boc-L-Lys (0.99 g, 4.0 mmol) in dimethylformamide (DMF; 10 mL) was added TEA (0.19 mL, 

1.3 mmol) and a solution of compound 6 (1.0 g, 2.7 mmol) in DMF (10 mL) dropwise. The 

reaction mixture was stirred at room temperature in the dark overnight and concentrated under 

vacuum. The residue was diluted with EA, washed with 0.1 M aqueous HCl solution, and brine. 

The organic layer was dried over anhydrous Na2SO4, filtered, and evaporated under vacuum. 

The residue was purified by flash column chromatography (CH2Cl2/MeOH = 20:1) to provide 

compound 7 as a viscous orange oil (0.57 g, 44% yield). 1H NMR (400 MHz, CD3OD) δ 7.55 

(d, J = 8.7 Hz, 1H), 7.30 (br, 1H), 7.06 (s, 1H), 6.86 (dd, J = 8.7, 2.4 Hz, 1H), 6.82 (d, J = 2.4 

Hz, 1H), 5.24 (s, 2H), 4.09 – 4.06 (m, 1H), 3.15 (t, J = 6.6 Hz, 2H), 1.84 – 1.81 (m, 1H), 1.69 

– 1.65 (m, 1H),1.58 – 1.52 (m, 2H), 1.42 (s, 11H). 13C NMR (101 MHz, CD3OD) δ 199.0, 176.3, 

163.5, 159.4, 158.2, 157.9, 144.7, 126.5, 123.2, 115.8, 112.7, 103.4, 80.5, 62.4, 54.8, 41.6, 

32.5, 30.3, 28.7, 24.1. HRMS calcd for C22H28N2O8S [M+H]+: 479.1494; found: 479.1495.  

 

 
N6-(((7-Hydroxy-2-thioxo-2H-chromen-4-yl)methoxy)carbonyl)-L-lysine (SCouK) 
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To a solution of compound 7 (0.57 g, 1.2 mmol) in anhydrous DCM (5 mL) was added 

trifluoroacetic acid (TFA; 5 mL) under a N2 atmosphere. After stirring for 1 h at room 

temperature in the dark, the reaction mixture was concentrated under vacuum to remove the 

solvent and TFA. The crude product was dissolved in MeOH and precipitated with Et2O. The 

precipitate was collected, redissolved in MeOH, and precipitated again with Et2O. The 

precipitate was collected and dried to give compound SCouK as an orange solid (0.35 g, 79% 

yield). 1H NMR (400 MHz, CD3OD) δ 7.62 (d, J = 8.7 Hz, 1H), 7.39 (br, 1H), 7.11 (s, 1H), 6.92 

– 6.88 (m, 2H), 5.29 (s, 2H), 3.74 – 3.71 (m, 1H), 3.21 – 3.19 (m, 2H), 1.96 – 1.94 (m, 1H), 

1.90 – 1.86 (m, 1H), 1.62 – 1.60 (m, 2H), 1.51 – 1.47 (m, 2H). 13C NMR (101 MHz, d6-DMSO) 

δ 196.4, 170.3, 162.8, 157.7, 155.3, 144.8, 125.9, 121.0, 115.2, 110.6, 102.2, 60.5, 53.9, 40.3, 

30.6, 29.0, 22.3. HRMS calcd for C17H20N2O6S [M-H]-: 379.0969; found: 379.0972. 

 

 
N2-(((9H-Fluoren-9-yl)methoxy)carbonyl)-N6-(((7-hydroxy-2-thioxo-2H-chromen-4-
yl)methoxy)carbonyl)-L-lysine (Fmoc-SCouK) 

To a solution of Nα-Fmoc-L-Lys (0.59 g, 1.6 mmol) in DMF (5 mL) was added TEA 

(0.08 mL, 0.5 mmol) and a solution of compound 6 (0.4 g, 1.1 mmol) in DMF (5 mL) dropwise. 

The reaction mixture was stirred at room temperature in the dark overnight and concentrated 

under vacuum. The residue was diluted with EA, washed with 0.1 M aqueous HCl solution, 

and brine. The organic layer was dried over anhydrous Na2SO4, filtered, and evaporated under 

vacuum. The residue was purified by flash column chromatography (CH2Cl2/MeOH = 20:1) to 

provide compound Fmoc-SCouK as a viscous orange oil (0.27 g, 41% yield). 1H NMR (400 

MHz, CD3OD) δ 7.75 (d, J = 7.4 Hz, 2H), 7.64 (dd, J = 7.2, 4.1 Hz, 2H), 7.46 (d, J = 8.4 Hz, 

1H), 7.35 (t, J = 7.4 Hz, 2H), 7.30 – 7.26 (m, 3H), 7.05 (s, 1H), 6.83 (dd, J = 6.9, 1.8 Hz, 1H), 

6.80 (s, 1H), 5.17 (s, 2H), 4.36 – 4.29 (m, 2H), 4.20 – 4.15 (m, 2H), 3.17 (t, J = 5.8 Hz, 2H), 

1.96 – 1.88 (m, 1H), 1.75 – 1.71 (m, 1H), 1.63 – 1.44 (m, 4H). 13C NMR (101 MHz, CD3OD) δ 

199.0, 175.9, 163.4, 159.3, 158.7, 157.9, 145.3, 145.2, 144.7, 142.5, 128.7, 128.2, 126.3, 

126.2, 123.0, 120.9, 115.7, 112.6, 103.4, 68.0, 62.3, 55.2, 41.5, 32.3, 30.3, 24.0. HRMS calcd 

for C32H30N2O8S [M+H]+: 603.1796; found: 603.1798. 
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Biological methods and materials  

Reagents and antibodies  

High-fidelity DNA polymerase, restriction enzymes, and dNTPs were obtained from 

New England Biolabs. Oligonucleotide primers and gene fragments were synthesized by 

Genewiz or Tsingke. Site-directed mutagenesis was performed with QuikChange II Site-

Directed Mutagenesis Kit (Agilent) with primers designed by Agilent Primer Design Program. 

Gibson assembly was carried out with Seamless Cloning Kit (Beyotime). Plasmid DNA 

isolation was carried out with Plasmid Mini/Midi Kit (Omega). Polyethylenimine (PEI) was 

purchased from Polysciences. Protease inhibitor cocktail (cOmplete ULTRA mini-Tablets) was 

purchased from Roche. Isopropyl-β-D-thiogalactoside (IPTG), kanamycin, and 

chloramphenicol were purchased from Sangon Biotech. 

Ne-Boc-L-Lysine (BocK) was purchased from Adamas and dissolved in 0.1 M NaOH 

as the stock solution (2 M). O-(2-nitrobenzyl)-tyrosine (ONBY) was purchased from Sigma-

Aldrich. HCK was synthesized in house according to literature.3 SCouK was synthesized as 

described in this manuscript and is available from the corresponding author upon request. 

Unless otherwise noted, unnatural amino acids (UAAs) were dissolved in DMSO as the stock 

solution (500 mM) and stored at −20 °C. All photocaged amino acids (ONBY, HCK, and 

SCouK) were protected from light during storage and handling. All UAAs were freshly diluted 

to the indicated working concentrations with culture medium immediately before use.  

Anti-6*His-HRP (HRP-66005, 1:5000 dilution), anti-GFP-HRP (66002-1-Ig, 1:10000 

dilution), anti-α-tubulin-HRP (HRP-66031, 1:5000 dilution), anti-β-actin-HRP (HRP-60008, 

1:5000 dilution), and anti-histone H3 (17168-1-AP, 1:10000 dilution) antibodies for western 

blotting were purchased from Proteintech. Anti-p-Src (6943T, 1:1000 dilution), anti-p-ERK-1/2 

(4370S, 1:2000 dilution), anti-ERK-1/2 (4695T, 1:1000 dilution), anti-p-TBK1 (5483S, 1:1000 

dilution), anti-p-IRF3 (phospho S386, 37829S, 1:1000 dilution) were purchased from Cell 

Signaling Technology. Anti-HA-Peroxidase (clone 3F10, 12013819001, 1:10000 dilution) was 

purchased from Roche. Anti-FLAG M2 antibody (F1804, 1:10000 dilution) was purchased from 

Sigma. Goat anti-rabbit and anti-mouse HRP secondary antibodies (1:10000 dilution) were 

purchased from Jackson ImmunoResearch Laboratories. α-Tubulin, β-actin, or histone H3 

was used as the loading control for western blotting analysis, depending on reagent availability 

in the lab. 

 

Plasmids and cloning  

For site-specific incorporation of UAAs in E. coli, the pBX-MmPylRS plasmid 

expressing wild-type PylRS from Methanosarcina mazei (Mm) was constructed from a 
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pBR322-derived plasmid pBK-JYRS (developed by Prof. Peter Schultz group),7, in our 

laboratory previously8 and used in this study. The wild-type MmPylRS in the pBX-MmPylRS 

plasmid was under the control of constitutive E. coli GlnRS promoter and terminator. Wild-type 

MmPylRS in pBX-MmPylRS was mutated at indicated sites with site-directed mutagenesis to 

generate PylRS mutation plasmids, such as pBX-SCouKRS. The pLX-EGFP-Y39TAG-PylT 

plasmid containing the MmPyl-tRNACUA gene and the C-terminally 6*His-tagged EGFP-

Y39TAG gene was constructed from the pACYC184-derived pYC-J17 backbone (developed 

by Prof. Peter Schultz group)7 in our laboratory previously8 and used in this study. The pLX-

sfGFP-N150TAG-PylT plasmid was generated by replacing the EGFP-Y39TAG gene in the 

pLX-EGFP-Y39TAG-PylT plasmid with the sfGFP-N150TAG gene. The pLX-EGFP-Y39TAG-

PylT and pLX-sfGFP-N150TAG-PylT plasmids contain the MmPyl-tRNACUA gene under the 

lpp promoter and rrnC terminator, as well as the EGFP-Y39TAG or sfGFP-N150TAG gene 

under the control of a bacteriophage T5 promoter and t0 terminator. The plasmid maps for 

pBX-MmPylRS, pBX-SCouKRS, pLX-EGFP-Y39TAG-PylT, and pLX-sfGFP-N150TAG-PylT 

are shown in Fig. S6 in Supplementary Information. 

For site-specific incorporation of UAAs in mammalian cells, the pEF1α-MmPylRS-PylT 

plasmid was previously reported by Prof. Jason Chin group9 and constructed in our 

laboratory.8 The pEF1α-MmPylRS-PylT plasmid contains the FLAG-tagged MmPylRS gene 

under the control of an EF1α core promoter and a SV40 poly(A) terminator, as well as four 

copies of MmPyl-tRNACUA under U6 promoters. A similar plasmid can be obtained from 

Addgene (a kind gift from Prof. Simon Elsaesser, Addgene #140009). To generate the pEF1α-

SCouKRS-PylT plasmid, the desired mutations (Y306A/L309A/Y384F/I405R) were introduced 

into the pEF1α-MmPylRS-PylT plasmid via site-directed mutagenesis. To generate the 

pEF1α-BhcKRS-PylT plasmid, the BhcKRS gene3 was synthesized by Genewiz and cloned 

into the pEF1α-MmPylRS-PylT plasmid to replace the original MmPylRS gene via Gibson 

assembly. To generate the pEF1α-ONBYRS-PylT plasmid, the ONBYRS gene10 was 

synthesized by Genewiz and cloned into the pEF1α-MmPylRS-PylT plasmid to replace the 

original MmPylRS gene via Gibson assembly. The plasmid maps for pEF1α-MmPylRS-PylT, 

pEF1α-SCouKRS-PylT, pEF1α-BhcKRS-PylT, and pEF1α-ONBYRS-PylT are shown in Fig. 

S10 in Supplementary Information.  

To generate the plasmids of pCMV-sfGFP-N150TAG, pCMV-EGFP-K85TAG-mCherry, 

pCMV-FLuc-K529TAG, and pCMV-NLuc-Y96TAG, the sfGFP-N150TAG, EGFP-K85TAG-

mCherry, fLuc-K529TAG, and NLuc-Y96TAG genes (synthesized by Genewiz) were 

individually cloned into the pCMV-HA vector (Clontech) via Gibson assembly. Similarly, the C-

terminally HA-tagged MEK1-ΔN-K97TAG gene was synthesized by Genewiz and cloned into 

the pCMV-HA vector (Clontech) via Gibson assembly to generate the pCMV-MEK1-ΔN-

K97TAG-HA plasmid. The C-terminally HA-tagged Src-Y527F-K295TAG gene was 
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synthesized by Genewiz and cloned into the pCMV-HA vector (Clontech) via Gibson assembly 

to generate the pCMV-Src-Y527F-K295TAG-HA plasmid. The C-terminally HA-tagged cGAS 

gene was synthesized by Genewiz and cloned into the pEF1α-MmPylRS-PylT plasmid to 

replace the original MmPylRS gene via Gibson assembly, generating the pEF1α-cGAS-HA 

plasmid. An amber TAG codon was introduced into the pEF1α-cGAS-HA plasmid at the K384, 

K394, or K414 site by site-directed mutagenesis to generate the pEF1α-cGAS-K384TAG-HA, 

pEF1α-cGAS-K394TAG-HA, and pEF1α-cGAS-K414TAG-HA plasmids. The maps for these 

plasmids are shown in Figure S10 in Supplementary Information.  

For the generation of STING-expressing stable cells, the N-terminally FLAG-tagged 

STING gene was synthesized by Genewiz and cloned into the pB-EF1a-NLuc-IRES-Puro 

plasmid (a gift from James Thomson, Addgene #130936) to replace the original NLuc gene 

via Gibson assembly, generating the pB-EF1a-FLAG-STING-IRES-Puro plasmid. The 

hyPBase plasmid used for stable integration was obtained from System Biosciences 

(#PB200A-1). The IFN-Beta_pGL3 plasmid was purchased from Miaoling Biology (#P5314). 

All plasmids used in this study are available from the corresponding author upon 

request. The key plasmids are also in the process of being deposited to Addgene. 

 

General information for photoirradiation  

For photoirradiation at 254 nm, 302 nm, and 365 nm, UV lamps (16 W; Shanghai 

GuCun, China) at the indicated wavelengths were used. For photoirradiation at 390 nm, 450 

nm, 520 nm, and 650 nm, flat-type light-emitting diode (LED) bulbs (45 W; Xuzhou AiJia, China) 

labeled at the indicated wavelengths (390–400 nm, 450–460 nm, 520–530 nm, and 640–660 

nm, respectively) were used. Samples were generally placed on ice and irradiated with the 

bulb or lamp positioned above the samples at a distance of 20 cm to ensure uniform light 

illumination. The spectral characteristics of the LEDs (named 390 nm LED, 450 nm LED, 520 

nm LED, and 650 nm LED) were determined at the sample plane using an HP350 portable 

spectroradiometer (380–780 nm; Zhejiang ShuangSe, China). The peak wavelength, central 

wavelength, dominant wavelength, centroid wavelength, half width, irradiance, and emission 

spectrum were characterized for each LED. 

 

Photolysis of Nα-Fmoc-SCouK in vitro 

Nα-Fmoc-SCouK was dissolved in CH3CN and diluted with PBS (20 mM, pH 7.4; 

CH3CN/PBS = 2:8, v/v) to a final concentration of 50 μM. For pH-dependent photolysis, PBS 

solutions (20 mM) of the indicated pH values were prepared and used to dilute the Nα-Fmoc-

SCouK stock solution to a final concentration of 50 μM (in CH3CN/PBS = 2:8, v/v). The 

resulting solutions were irradiated with a 520 nm LED (22 mW/cm2) for varying periods (10, 
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30, 60, and 120 s). The resulting mixture was analyzed by LC-MS on a Q Exactive Focus LC-

MS/MS System (ThermoFisher). The UV detector was set at 254 nm. Samples were eluted 

from a Hypersil C18 UHPLC column (100 × 2.1 mm, 1.9 μm) with a linear gradient from 10% 

acetonitrile/90% water containing 0.1 % FA to 95% acetonitrile/5% water containing 0.1 % FA 

at a flow rate of 0.28 mL/min. LC-MS spectra were analyzed with the Xcalibur software 

(ThermoFisher). The peak areas of Na-Fmoc-SCouK and Na-Fmoc-K in the HPLC traces were 

used to calculate the conversions and yields at different irradiation times, using known 

concentrations of Na-Fmoc-SCouK and Na-Fmoc-K as references. The experiments were 

performed in four replicates with reproducible results. Each replicate dataset of Na-Fmoc-

SCouK conversion was individually fitted to a nonlinear one-phase exponential decay model 

in the Prism software (GraphPad Software) to calculate the half-life (t1/2) of SCouK 

photodecaging. The resulting half-life values were averaged, and the standard deviation (SD) 

was calculated.  

 

Screening of MmPylRS variants for SCouK incorporation 

The E. coli strain BL21(DE3) was co-transformed with the pLX-EGFP-Y39TAG-PylT 

plasmid and individual pBX-MmPylRS mutant plasmids. The transformed bacterial cells were 

grown in Luria Broth (LB) medium containing kanamycin (40 μg/mL) and chloramphenicol (34 

μg/mL) overnight at 37 °C. The cultures were then inoculated by 1:100 dilution into fresh LB 

medium supplemented with kanamycin (40 μg/mL) and chloramphenicol (34 μg/mL) at 37 °C. 

When the OD600 reached 0.6, SCouK (1 mM) was added into the bacterial cultures. After 0.5 

h, IPTG (1 mM) was added into the culture to induce the protein expression at 37 °C for 10 h. 

EGFP fluorescence intensities of individual bacterial cultures were measured on a Biotek 

Synergy H1 microplate reader and compared with the corresponding control cultures without 

the addition of SCouK.  

 

Incorporation of SCouK into proteins in E. coli 

The E. coli strain BL21(DE3) was co-transformed with the pLX-sfGFP-N150TAG-PylT 

plasmid and the pBX-SCouKRS plasmid. The transformed bacterial cells were grown in LB 

medium containing kanamycin (40 μg/mL) and chloramphenicol (34 μg/mL) overnight at 37 °C. 

The culture was then inoculated by 1:100 dilution into fresh LB medium supplemented with 

kanamycin (40 μg/mL) and chloramphenicol (34 μg/mL) at 37 °C. SCouK (1 mM) was added 

into the bacterial culture when the OD600 reached 0.6. For concentration-dependent 

incorporation of SCouK into sfGFP-N150TAG, SCouK at different concentrations (from 0 mM 

to 2 mM) was added into the bacterial culture. After 0.5 h, IPTG (1 mM) was added into the 

culture to induce the protein expression at 37 °C for 10 h. Cells were harvested and lysed with 
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4% SDS lysis buffer (4% SDS, 150 mM NaCl, 50 mM triethanolamine, pH 7.4) at 95 °C for 5 

min. The resulting cell lysates were centrifuged at 16,000g for 5 min at room temperature. 

Protein concentrations were determined by the BCA assay (Pierce). Finally, the proteins were 

separated on 4–20% SDS-PAGE gels (Genscript) and analyzed by Western blotting and 

Coomassie Brilliant Blue staining.  

 

Recombinant purification of SCouK-incorporated sfGFP from E. coli  

For purification of 6*His-tagged sfGFP-N150SCouK from the E. coli culture, the 

BL21(DE3) strain was co-transformed with the pLX-sfGFP-N150TAG-PylT plasmid and the 

pBX-SCouKRS plasmid. The transformed bacterial cells were grown in LB medium containing 

kanamycin (40 μg/mL) and chloramphenicol (34 μg/mL) overnight at 37 °C. The culture was 

then inoculated by 1:100 dilution into fresh LB medium supplemented with kanamycin (40 

μg/mL) and chloramphenicol (34 μg/mL) at 37 °C. SCouK (1 mM) was added into the bacterial 

culture when the OD600 reached 0.6. After 0.5 h, IPTG (1 mM) was added into the culture to 

induce the protein expression at 37 °C for 10 h. Cells were harvested and lysed with a sonic 

disruptor (Scientz, JY92-IIN) in the binding buffer (20 mM Tris-HCl, 500 mM NaCl, 10% 

glycerol, 10 mM imidazole, pH 8.0) containing the protease inhibitor cocktail, 

phenylmethylsulfonyl fluoride (PMSF), deoxyribonuclease I, and lysozyme. After 

centrifugation, the supernatant was purified by Ni-NTA Sefinose Resin 6FF (Sangon, 

cat#C600033-0025) according to the manufacturer’s protocol and eluted with the elution buffer 

(binding buffer supplemented with 250 mM imidazole). The purified protein was stored at 

−80 °C. For photoactivation of the recombinant protein in vitro, sfGFP-N150SCouK (1 μM) in 

PBS was irradiated with a 520 nm LED (22 mW/cm2) for 30 s.  

 

Mass spectrometry analysis of recombinant proteins 

The recombinant proteins were desalted with 10 kDa Amicon centrifugal filters 

(Millipore, cat#MRCPRT010), washed three times with water, and reconstituted into 0.01% 

ammonia solution. The resulting samples were analyzed on a Q Exactive Focus LC-MS/MS 

system (ThermoFisher) equipped with a nano-ESI ionization source. The mass spectra were 

deconvoluted with the BioPharma Finder software (ThermoFisher).  

 

Mammalian cell culture and transfection  

HEK293T cells were obtained from the American Type Culture Collection (ATCC). 

Cells were grown in Dulbecco’s modified Eagle’s medium (DMEM; Cytiva, cat#SH30243.01) 

supplemented with 10% fetal bovine serum (FBS; Biological Industries, cat#04-001-1ACS) in 

a humidified incubator at 37 °C with 5% CO2. For transfection, cells were grown to 70% 



S32 

 

confluence and transfected with indicated plasmids using PEI (Polysciences) for 18–24 h in 

cell growth media.  

To generate HEK293T-STING stable cell line, the PiggyBac transposon system was 

used. Briefly, HEK293T cells seeded in 6-well plate were transfected with 1 μg of the pB-

EF1a-FLAG-STING-IRES-Puro plasmid (constructed in this study) together with 1 μg of the 

hyPBase plasmid (System Biosciences) for 24 h. Transfected cells were further grown in fresh 

growth media for 24 h and then selected with 3-6 μg/mL puromycin for 7 days. The stable cell 

line was maintained in growth media containing 1 μg/mL puromycin after selection. 

 

Incorporation of SCouK into proteins in mammalian cells 

HEK293T cells were seeded in 6-well plates and cultured overnight in cell culture 

media. On the next day cells were co-transfected with the pCMV-sfGFP-N150TAG plasmid 

(0.65 μg per well) and the pEF1α-MmPylRS-PylT or pEF1α-SCouKRS-PylT plasmid (0.35 μg 

per well) using PEI (2.5 μg per well) in cell culture media in the absence or presence of UAA 

(0.5 mM unless otherwise stated). For the expression of SCouK-modified proteins, pEF1α-

SCouKRS-PylT was used, while pEF1α-MmPylRS-PylT was used for the incorporation of 

BocK. After transfection for 24 h, cells were lysed with 4% SDS lysis buffer containing 

benzonase by sonication and vortexing. The resulting cell lysates were centrifuged at 16,000g 

for 5 min at room temperature. Protein concentrations were determined by the BCA assay 

(Pierce). Proteins were separated on 4–20% SDS-PAGE gels (Genscript) and analyzed by 

western blotting. Alternatively, cells were imaged live in FluoroBrite DMEM (ThermoFisher) 

using an Olympus IX73 inverted fluorescence microscope equipped with a 10× objective lens. 

The blue filter set (bandpass 460–495 nm) was used for recording EGFP signals.  

Widefield fluorescence images were captured under identical acquisition settings and 

exposure times for all samples and processed in the cellSens Dimension software (Olympus). 

Images were saved in the native VSI format for Olympus cellSens software and exported as 

uncompressed TIFF files for quantification. Image analysis and quantification were performed 

with ImageJ software (NIH) as described previously.11 Briefly, images were opened in ImageJ 

and converted to 8-bit grayscale versions (Image → Color → Split channels). The green sfGFP 

channel was used and thresholded using the Image → Adjust → Threshold functions to isolate 

fluorescent signals from background and select all fluorescent cells for quantification. The 

default threshold was generally used across different samples. The measurement parameters 

were selected using the Analyze → Set Measurements functions to make sure that gray value 

parameters and the Limit to Threshold option was enabled. Finally, the mean fluorescence 

intensity of the areas above the threshold was measured and exported for analysis. Each 

experimental condition was performed in at least three biological replicates. The number of 
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biological replicates was specified in the corresponding figure legend. For each biological 

replicate, at least three representative images from different fields of view per well were 

quantified and averaged to obtain the mean fluorescence intensity of the replicate. All mean 

fluorescence intensity data were pooled and normalized for statistical analysis. The relative 

mean fluorescence intensity was reported as mean ± SD. 

 

Photophysical characterization of SCouK 

For the photophysical characterization, SCouK and HCK were dissolved in DMSO to 

make the stock solutions. UV-Vis absorption spectra of SCouK and HCK were recorded on a 

UV-Vis spectrophotometer (Techcomp UV-1000) at 10 μM concentrations in PBS (20 mM, pH 

= 7.4) containing 0.01% DMSO. For pH-dependent absorption measurement, PBS solutions 

(20 mM) at indicated pH values were prepared and used to dilute the SCouK stock solution to 

a final concentration of 10 μM. Fluorescence spectra of SCouK and HCK were recorded on a 

Hitachi F-4600 fluorescence spectrophotometer at 10 μM concentrations in PBS (20 mM, pH 

= 7.4) containing 0.01% DMSO.  

 

Cytotoxicity of SCouK and its decaging product 

Cell Counting Kit-8 (CCK-8) was used to measure the cytotoxicity of SCouK and its 

decaging product. Briefly, HEK293T cells were seeded in 96-well plates (~5,000 cells per well) 

and cultured overnight. Cells were treated with SCouK at different concentrations for 24 h. For 

assessing the decaging product of SCouK, cells were treated with SCouK at different 

concentrations for 0.5 h, irradiated with a 520 nm LED (22 mW/cm2) for 1 min, and further 

cultured for 24 h. After that, CCK-8 solution (HY-K0301, MedChemExpress) was added to the 

cells (20 μL per well) and incubated at 37 °C for 1–2 h. The absorbance of each well was 

measured at the wavelength of 450 nm with a Cytation 5 Multi-Mode Reader (BioTek).  

 

Photoactivation of EGFP in live mammalian cells 

HEK293T cells were seeded in poly-D-lysine-coated 35-mm dishes and cultured 

overnight in growth media. On the next day cells were co-transfected with the plasmids of 

pCMV-EGFP-K85TAG-mCherry (0.65 μg per dish) and pEF1α-SCouKRS-PylT (0.35 μg per 

dish) using PEI (2.5 μg per dish) in cell culture media in the presence of SCouK (0.2 mM). 

After incubation for 24 h, cells were washed with DMEM twice over 2 h and irradiated under 

different wavelengths (365, 390, 450, 520, and 650 nm; Table S2) for 1 min, or with a 520 

LED (22 mW/cm2) for varying periods (10, 30, 60, 120, and 300 s) in FluoroBrite DMEM 

(ThermoFisher). After that, cells were cultured in a humidified incubator at 37 °C with 5% CO2 

for 2 h. Cells were imaged live in FluoroBrite DMEM using a Nikon A1R confocal fluorescence 



S34 

 

microscope equipped with a 20× objective lens. For the EGFP channel, the 488 nm laser was 

used as the excitation, and emission was collected between 500 nm to 550 nm. For the 

mCherry channel, the 561 nm laser was used as the excitation, and emission was collected 

between 570 nm to 620 nm. 

For localized irradiation, HEK293T cells were transfected and prepared as described 

above. The culture dish was transferred to an Olympus IX73 inverted fluorescence microscope, 

focused using the bright-field channel under a 60× objective lens, and locally irradiated for 10 

s using a mercury lamp equipped with a green excitation filter set (bandpass 530–550 nm). 

After irradiation, cells were cultured for 2 h and then imaged live in FluoroBrite DMEM using 

an Olympus IX73 inverted fluorescence microscope equipped with a 10× objective lens. The 

blue filter set (bandpass 460–495 nm) and yellow filter set (bandpass 560–580 nm) were used 

for recording EGFP and mCherry signals, respectively.  

Confocal fluorescence images were captured under identical acquisition settings and 

exposure times for all samples and processed in the NIS Elements software (Nikon). Images 

were saved in the native ND2 format for Nikon NIS Elements software and exported as 

uncompressed TIFF files for quantification. Image analysis and quantification were performed 

with ImageJ software (NIH) as described previously.11 Briefly, images were opened in ImageJ 

and converted to 8-bit grayscale versions (Image → Color → Split channels). The green EGFP 

and red mCherry channels were used and thresholded using the Image → Adjust → Threshold 

functions to isolate fluorescent signals from background and select all fluorescent cells for 

quantification. The default threshold was generally used across different samples. The 

measurement parameters were selected using the Analyze → Set Measurements functions 

to make sure that gray value parameters and the Limit to Threshold option was enabled. 

Finally, the mean fluorescence intensity of the areas above the threshold was measured and 

exported for analysis. Each experimental condition was performed in at least three biological 

replicates. The number of biological replicates was specified in the corresponding figure 

legend. For each biological replicate, at least three representative images from different fields 

of view per well were quantified and averaged to obtain the mean fluorescence intensity of the 

replicate. The ratio of mean EGFP intensity to mean mCherry intensity was calculated. All 

EGFP/mCherry ratio data were pooled and normalized for statistical analysis. The relative 

EGFP/mCherry ratio was reported as mean ± SD. 

 

Photoactivation of luciferase in live mammalian cells 

HEK293T cells were seeded in 60-mm dishes and cultured overnight in growth media. 

On the next day cells were co-transfected with the plasmids of pCMV-FLuc-K529TAG (1.3 μg 

per dish) and pEF1α-SCouKRS-PylT (0.7 μg per dish) using PEI (5 μg per dish) in cell culture 
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media in the presence of SCouK (0.2 mM). After incubation for 24 h, cells were washed with 

DMEM twice over 2 h and collected. Cells were resuspended in PBS and divided into a 96-

well black plate, which allowed consistent expression across wells, minimized reagent 

consumption, and enabled quantitative bioluminescence detection using a plate reader. Cells 

were then irradiated in PBS under different wavelengths (365, 390, 450, 520, and 650 nm; 

Table S2) for 1 min. Finally, luciferase activities were measured using a Bright-Lumi luciferase 

assay kit (Beyotime, RG051M) on a Biotek Synergy H1 microplate reader. Bioluminescence 

images were recorded on a Chemidoc MP imaging system (Biorad) using the 

chemiluminescence detection mode. For the analysis of cells expressing FLuc-K529HCK, 

HEK293T cells were co-transfected with the plasmids of pCMV-FLuc-K529TAG (1.3 μg per 

dish) and pEF1α-BhcKRS-PylT (0.7 μg per dish) using PEI (5 μg per dish) in cell culture media 

in the presence of HCK (0.2 mM). For the analysis of cells expressing FLuc-K529BocK, 

HEK293T cells were co-transfected with the plasmids of pCMV-FLuc-K529TAG (1.3 μg per 

dish) and pEF1α-MmPylRS-PylT (0.7 μg per dish) using PEI (5 μg per dish) in cell culture 

media in the presence of BocK (0.2 mM). 

 

Photoactivation of kinase in live mammalian cells 

HEK293T cells were seeded in 12-well plates and cultured overnight in growth media. 

On the next day cells were co-transfected with the plasmids of pEF1α-SCouKRS-PylT (0.35 

μg per well) and pCMV-MEK1-ΔN-K97TAG-HA or pCMV-Src-Y527F-K295TAG-HA (0.65 μg 

per well) using PEI (2.5 μg per well) in cell culture media in the presence of SCouK (0.2 mM). 

For the negative control experiments, HEK293T cells were co-transfected with the plasmids 

of pEF1α-MmPylRS-PylT (0.35 μg per well) and pCMV-MEK1-ΔN-K97TAG-HA or pCMV-Src-

Y527F-K295TAG-HA (0.65 μg per well) using PEI (2.5 μg per well) in cell culture media in the 

presence of BocK (0.2 mM). After incubation for 24 h, cells were washed with DMEM twice 

over 2 h and irradiated with a 520 nm LED (22 mW/cm2) for 1 min in FluoroBrite DMEM 

(ThermoFisher). After that, cells were cultured in growth media in a humidified incubator at 

37 °C with 5% CO2 for 2 h. Cells were harvested and lysed with 4% SDS lysis buffer containing 

benzonase for 5 min at 95 °C. The resulting cell lysates were centrifuged at 16,000g for 5 min 

at room temperature. Protein concentrations were determined by the BCA assay (Pierce). 

Proteins were separated on 4–20% SDS-PAGE gels (Genscript) and analyzed by western 

blotting.  

 

Photoactivation of cGAS in live mammalian cells 

HEK293T-STING cells were seeded in 12-well plates and cultured overnight in growth 

media. On the next day cells were co-transfected with the plasmids of pEF1α-SCouKRS-PylT 
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(0.28 μg per well) and pEF1α-cGAS-HA with K384, K394, or K414 mutated to TAG (0.52 μg 

per well) using PEI (2 μg per well) in cell culture media in the presence of SCouK (0.2 mM). 

After incubation for 24 h, cells were washed with DMEM twice over 2 h and irradiated with a 

520 nm LED (22 mW/cm2) for 1 min in FluoroBrite DMEM (ThermoFisher). After that, cells 

were cultured in culture media in a humidified incubator at 37 °C with 5% CO2. For SCouK 

incorporation sites analysis, cells were harvested at 4 h after irradiation, and lysed with 4% 

SDS lysis buffer containing benzonase for 5 min at 95 °C. For kinetics analysis, cells were 

harvested at indicated time points after irradiation. The resulting cell lysates were centrifuged 

at 16,000g for 5 min at room temperature. Protein concentrations were determined by the BCA 

assay (Pierce). Proteins were separated on 4–20% SDS-PAGE gels (Genscript) and analyzed 

by western blotting. 

For luciferase-based IFNβ expression assay, HEK293T-STING cells were co-

transfected with pEF1α-SCouKRS-PylT (0.28 μg per well), pEF1α-cGAS-K384TAG-HA (0.4 

μg per well), and IFN-Beta_pGL3 (0.14 μg per well) using PEI (2 μg per well) in cell culture 

media in the presence of SCouK (0.2 mM). The culture and irradiation conditions were the 

same as above. Cells were harvested at 6 h after irradiation and divided into a 96-well black 

plate for luciferase assay or lysed for SDS-PAGE. Luciferase activities were measured using 

a Bright-Lumi luciferase assay kit (Beyotime, RG051M) on a Biotek Synergy H1 microplate 

reader. Bioluminescence images were recorded on a Chemidoc MP imaging system (Biorad) 

using the chemiluminescence detection mode. 

 

Sequential photoactivation 

For the sequential photoactivation experiment, FLuc-K529SCouK and NLuc-

Y96ONBY were separately expressed in HEK293T cells. FLuc-K529SCouK was expressed 

as above. NLuc-Y96ONBY was expressed by co-transfecting cells with plasmids of pCMV-

NLuc-Y96TAG and pEF1α-ONBYRS-PylT in the presence of 0.2 mM ONBY. After 24 h 

transfection, cells were washed with DMEM twice over 2 h and then resuspended in PBS. 

Fluc-K529SCouK- and NLuc-Y96ONBY-expressing cells were mixed at 1:1 ratio or mixed with 

non-transfected HEK293T cells at 1:1 ratio. The cells were divided into a 96-well black plate 

and irradiated in PBS under different wavelengths for 1 min or sequentially with two 

wavelengths for 30 s each. Luciferase activities were measured using the Nano&Firefly-Glo 

Luciferase Reporter Assay Kit (Meilunbio, MA0522) on a Biotek Synergy H1 microplate reader. 

Bioluminescence images were recorded on a Chemidoc MP imaging system (Biorad) using 

the chemiluminescence detection mode. 
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Western blotting 

SDS-PAGE gels were transferred to nitrocellulose membranes using Genscript 

eBlot™ L1 wet protein transfer system. The membranes were blocked with 5% nonfat milk in 

PBST (0.05% Tween-20 in PBS) for 30 min at room temperature and incubated with the 

primary antibody at 4 °C overnight. Membranes were washed with PBST three times and 

incubated with the second antibody at room temperature for 2 h. Membranes were finally 

washed with PBST three times, developed using ECL substrates, and imaged with a 

Chemidoc MP imaging system (Biorad).  

Western blots grouped together were performed using cell lysates prepared from the 

same cell batches. For probing multiple proteins, membranes were sectioned into strips by 

molecular weight using a razor blade, and the strips were incubated with the respective 

antibodies. When proteins of similar apparent molecular weights (e.g., actin and FLAG-STING) 

were detected, membranes were first incubated with the antibody for the first protein of interest, 

stripped with Restore Western Blot Stripping Buffer (ThermoFisher), and then reprobed with 

the antibody for the second protein of interest. If a single membrane after sectioning was 

insufficient to detect all targets, identical lysate aliquots were electrophoresed in parallel with 

equal loading amounts. Consistent, specific, and non-overlapping detection across all 

experiments was ensured throughout the study. Unprocessed original images of all blots, with 

the membrane edges and molecular weight marker bands visible, are provided in this 

document. 

 

Quantification and statistical analysis  

Data were generally shown as mean ± SD calculated from biological replicates (shown 

as n). The method (one-way ANOVA) for determining significance is indicated in the 

corresponding figure legend, with the replication number of independent biological 

experiments specified. Significance was denoted as follows: ns = non-significant (p > 0.05), * 

p < 0.05, ** p < 0.01, *** p < 0.001, and **** p < 0.0001. Statistical analyses were performed 

with the Prism software (GraphPad Software).  

 

Protein sequences  

Wild-type MmPylRS: 

MDYKDDDDKMDKKPLNTLISATGLWMSRTGTIHKIKHHEVSRSKIYIEMACGDHLVV

NNSRSSRTARALRHHKYRKTCKRCRVSDEDLNKFLTKANEDQTSVKVKVVSAPTRTKKAM

PKSVARAPKPLENTEAAQAQPSGSKFSPAIPVSTQESVSVPASVSTSISSISTGATASALVK

GNTNPITSMSAPVQASAPALTKSQTDRLEVLLNPKDEISLNSGKPFRELESELLSRRKKDLQ

QIYAEERENYLGKLEREITRFFVDRGFLEIKSPILIPLEYIERMGIDNDTELSKQIFRVDKNFCL
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RPMLAPNLYNYLRKLDRALPDPIKIFEIGPCYRKESDGKEHLEEFTMLNFCQMGSGCTRENL

ESIITDFLNHLGIDFKIVGDSCMVYGDTLDVMHGDLELSSAVVGPIPLDREWGIDKPWIGAGF

GLERLLKVKHDFKNIKRAARSESYYNGISTNL 

 

SCouKRS (mutations compared to wild-type MmPylRS are marked in red): 

MDYKDDDDKMDKKPLNTLISATGLWMSRTGTIHKIKHHEVSRSKIYIEMACGDHLVV

NNSRSSRTARALRHHKYRKTCKRCRVSDEDLNKFLTKANEDQTSVKVKVVSAPTRTKKAM

PKSVARAPKPLENTEAAQAQPSGSKFSPAIPVSTQESVSVPASVSTSISSISTGATASALVK

GNTNPITSMSAPVQASAPALTKSQTDRLEVLLNPKDEISLNSGKPFRELESELLSRRKKDLQ

QIYAEERENYLGKLEREITRFFVDRGFLEIKSPILIPLEYIERMGIDNDTELSKQIFRVDKNFCL

RPMLAPNLANYARKLDRALPDPIKIFEIGPCYRKESDGKEHLEEFTMLNFCQMGSGCTREN

LESIITDFLNHLGIDFKIVGDSCMVFGDTLDVMHGDLELSSAVVGPRPLDREWGIDKPWIGA

GFGLERLLKVKHDFKNIKRAARSESYYNGISTNL 

 

BhcKRS (mutations compared to wild-type MbPylRS are marked in red): 

MDKKPLDVLISATGLWMSRTGTLHKIKHHEVSRSKIYIEMACGDHLVVNNSRSCRTA

RAFRHHKYRKTCKRCRVSDEDINNFLTRSTESKNSVKVRVVSAPKVKKAMPKSVSRAPKPL

ENSVSAKASTNTSRSVPSPAKSTPNSSVPASAPAPSLTRSQLDRVEALLSPEDKISLNMAKP

FRELEPELVTRRKNDFQRLYTNDREDYLGKLERDITKFFVDRGFLEIKSPILIPAEYVERMGI

NNDTELSKQIFRVDKNLCLRPMLAPTLANYMRKLDRILPGPIKIFEVGPCYRKESDGKEHLE

EFTMVNFCQMGSGCTRENLEALIKEFLDYLEIDFEIVGDSCMVYGDTLDIMHGDLELSSAVV

GPVSLDREWGIDKPWIGAGFGLERLLKVMHGFKNIKRASRSESYYNGISTNL 

 

ONBYRS (mutations compared to wild-type MbPylRS are marked in red): 

MDKKPLDVLISATGLWMSRTGTLHKIKHHEVSRSKIYIEMACGDHLVVNNSRSCRTA

RAFRHHKYRKTCKRCRVSDEDINNFLTRSTESKNSVKVRVVSAPKVKKAMPKSVSRAPKPL

ENSVSAKASTNTSRSVPSPAKSTPNSSVPASAPAPSLTRSQLDRVEALLSPEDKISLNMAKP

FRELEPELVTRRKNDFQRLYTNDREDYLGKLERDITKFFVDRGFLEIKSPILIPAEYVERMGI

NNDTELSKQIFRVDKNLCLRPMLAPTFYNYMRKLDRILPGPIKIFEVGPCYRKESDGKEHLE

EFTMVGFGQMGSGCTRENLEALIKEFLDYLEIDFEIVGDSCMVFGDTLDIMHGDLELSSAVV

GPVSLDREWGIDKPWIGAGFGLERLLKVMHGFKNIKRASRSESYYNGISTNL 

 

EGFP-Y39TAG (* denotes the UAA site): 

MVSKGEELFTGVVPILVELDGDVNGHKFSVSGEGEGDAT*GKLTLKFICTTGKLPVP

WPTLVTTLTYGVQCFSRYPDHMKQHDFFKSAMPEGYVQERTIFFKDDGNYKTRAEVKFEG

DTLVNRIELKGIDFKEDGNILGHKLEYNYNSHNVYIMADKQKNGIKVNFKIRHNIEDGSVQLA
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DHYQQNTPIGDGPVLLPDNHYLSTQSALSKDPNEKRDHMVLLEFVTAAGITLGMDELYKRS

HHHHHH 

 

sfGFP-N150TAG (* denotes the UAA site): 

MVSKGEELFTGVVPILVELDGDVNGHKFSVRGEGEGDATNGKLTLKFICTTGKLPV

PWPTLVTTLTYGVQCFSRYPDHMKRHDFFKSAMPEGYVQERTISFKDDGTYKTRAEVKFE

GDTLVNRIELKGIDFKEDGNILGHKLEYNFNSH*VYITADKQKNGIKANFKIRHNVEDGSVQL

ADHYQQNTPIGDGPVLLPDNHYLSTQSVLSKDPNEKRDHMVLLEFVTAAGITHGMDELYKG

SHHHHHH 

 

EGFP-K85TAG-mCherry (* denotes the UAA site): 

MVSKGEELFTGVVPILVELDGDVNGHKFSVSGEGEGDATYGKLTLKFICTTGKLPVP

WPTLVTTLTYGVQCFSRYPDHMKQHDFF*SAMPEGYVQERTIFFKDDGNYKTRAEVKFEG

DTLVNRIELKGIDFKEDGNILGHKLEYNYNSHNVYIMADKQKNGIKVNFKIRHNIEDGSVQLA

DHYQQNTPIGDGPVLLPDNHYLSTQSALSKDPNEKRDHMVLLEFVTAAGITLGMDELYKSG

LRSRVATMVSKGEEDNMAIIKEFMRFKVHMEGSVNGHEFEIEGEGEGRPYEGTQTAKLKVT

KGGPLPFAWDILSPQFMYGSKAYVKHPADIPDYLKLSFPEGFNWERVMNFEDGGVVTVTQ

DSSLQDGEFIYKVKLRGTNFPSDGPVMQCRTMGWEASTERMYPEDGALKGEIKQRLKLKD

GGHYDAEVKTTYKAKKPVQLPGAYNVDIKLDILSHNEDYTIVEQYERAEGRHSTGGMDELY

K 

 

FLuc-K529TAG (* denotes the UAA site): 

MEDAKNIKKGPAPFYPLEDGTAGEQLHKAMKRYALVPGTIAFTDAHIEVDITYAEYF

EMSVRLAEAMKRYGLNTNHRIVVCSENSLQFFMPVLGALFIGVAVAPANDIYNERELLNSM

GISQPTVVFVSKKGLQKILNVQKKLPIIQKIIIMDSKTDYQGFQSMYTFVTSHLPPGFNEYDFV

PESFDRDKTIALIMNSSGSTGLPKGVALPHRTACVRFSHARDPIFGNQIIPDTAILSVVPFHH

GFGMFTTLGYLICGFRVVLMYRFEEELFLRSLQDYKIQSALLVPTLFSFFAKSTLIDKYDLSNL

HEIASGGAPLSKEVGEAVAKRFHLPGIRQGYGLTETTSAILITPEGDDKPGAVGKVVPFFEA

KVVDLDTGKTLGVNQRGELCVRGPMIMSGYVNNPEATNALIDKDGWLHSGDIAYWDEDEH

FFIVDRLKSLIKYKGYQVAPAELESILLQHPNIFDAGVAGLPDDDAGELPAAVVVLEHGKTMT

EKEIVDYVASQVTTAKKLRGGVVFVDEVPKGLTG*LDARKIREILIKAKKGGKIAVHHHHHH 

 

MEK1-ΔN-K97TAG (* denotes the UAA site): 

MPKKKPTPIQLNPAPDGSAVNGTSSAETNLEALQKKLEELELDEQQRKRLEAFLTQ

KQKVGELKDDDFEKISELGAGNGGVVFKVSHKPSGLVMAR*LIHLEIKPAIRNQIIRELQVLHE

CNSPYIVGFYGAFYSDGEISICMEHMDGGSLDQVLKKAGRIPEQILGKVSIAVIKGLTYLREK

HKIMHRDVKPSNILVNSRGEIKLCDFGVSGQLIDSMANSFVGTRSYMSPERLQGTHYSVQS
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DIWSMGLSLVEMAVGRYPIPPPDAKELELMFGCQVEGDAAETPPRPRTPGRPLSSYGMDS

RPPMAIFELLDYIVNEPPPKLPSGVFSLEFQDFVNKCLIKNPAERADLKQLMVHAFIKRSDAE

EVDFAGWLCSTIGLNQPSTPTHAAGVLMAMSYPYDVPDYA 

 

Src-Y527F-K295TAG (* denotes the UAA site): 

MGSNKSKPKDASQRRRSLEPAENVHGAGGGAFPASQTPSKPASADGHRGPSAAFAPAAA

EPKLFGGFNSSDTVTSPQRAGPLAGGVTTFVALYDYESRTETDLSFKKGERLQIVNNTEGD

WWLAHSLSTGQTGYIPSNYVAPSDSIQAEEWYFGKITRRESERLLLNAENPRGTFLVRESE

TTKGAYCLSVSDFDNAKGLNVKHYKIRKLDSGGFYITSRTQFNSLQQLVAYYSKHADGLCH

RLTTVCPTSKPQTQGLAKDAWEIPRESLRLEVKLGQGCFGEVWMGTWNGTTRVAI*TLKP

GTMSPEAFLQEAQVMKKLRHEKLVQLYAVVSEEPIYIVTEYMSKGSLLDFLKGETGKYLRLP

QLVDMAAQIASGMAYVERMNYVHRDLRAANILVGENLVCKVADFGLARLIEDNEYTARQGA

KFPIKWTAPEAALYGRFTIKSDVWSFGILLTELTTKGRVPYPGMVNREVLDQVERGYRMPC

PPECPESLHDLMCQCWRKEPEERPTFEYLQAFLEDYFTSTEPQYQPGENLLMAMSYPYDV

PDYA 

 

Wild-type STING: 

MDYKDHDGDYKDHDIDYKDDDDKMPHSSLHPSIPCPRGHGAQKAALVLLSACLVTL

WGLGEPPEHTLRYLVLHLASLQLGLLLNGVCSLAEELRHIHSRYRGSYWRTVRACLGCPLR

RGALLLLSIYFYYSLPNAVGPPFTWMLALLGLSQALNILLGLKGLAPAEISAVCEKGNFNVAH

GLAWSYYIGYLRLILPELQARIRTYNQHYNNLLRGAVSQRLYILLPLDCGVPDNLSMADPNIR

FLDKLPQQTGDRAGIKDRVYSNSIYELLENGQRAGTCVLEYATPLQTLFAMSQYSQAGFSR

EDRLEQAKLFCRTLEDILADAPESQNNCRLIAYQEPADDSSFSLSQEVLRHLRQEEKEEVTV

GSLKTSAVPSTSTMSQEPELLISGMEKPLPLRTDFS 

 

cGAS-K384TAG (* denotes the UAA site): 

MQPWHGKAMQRASEAGATAPKASARNARGAPMDPTESPAAPEAALPKAGKFGPA

RKSGSRQKKSAPDTQERPPVRATGARAKKAPQRAQDTQPSDATSAPGAEGLEPPAAREP

ALSRAGSCRQRGARCSTKPRPPPGPWDVPSPGLPVSAPILVRRDAAPGASKLRAVLEKLK

LSRDDISTAAGMVKGVVDHLLLRLKCDSAFRGVGLLNTGSYYEHVKISAPNEFDVMFKLEV

PRIQLEEYSNTRAYYFVKFKRNPKENPLSQFLEGEILSASKMLSKFRKIIKEEINDIKDTDVIM

KRKRGGSPAVTLLISEKISVDITLALESKSSWPASTQEGLRIQNWLSAKVRKQLRLKPFYLVP

KHAKEGNGFQEETWRLSFSHIE*EILNNHGKSKTCCENKEEKCCRKDCLKLMKYLLEQLKE

RFKDKKHLDKFSSYHVKTAFFHVCTQNPQDSQWDRKDLGLCFDNCVTYFLQCLRTEKLEN

YFIPEFNLFSSNLIDKRSKEFLTKQIEYERNNEFPVFDEFLMAMSYPYDVPDYA 

 

NLuc-Y96TAG (* denotes the UAA site): 
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MVFTLEDFVGDWRQTAGYNLDQVLEQGGVSSLFQNLGVSVTPIQRIVLSGENGLKI

DIHVIIPYEGLSGDQMGQIEKIFKVVYPVDDHHFKVILH*GTLVIDGVTPNMIDYFGRPYEGIAV

FDGKKITVTGTLWNGNKIIDERLINPDGSLLFRVTINGVTGWRLCERILAHHHHHH 
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NMR spectra  
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